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История изменений
Версия
продукта

Руководство по
эксплуатации

Изменения Примечания

2.09.xx BA00065S/04/RU/
01.12

– Оригинальное руководство по
эксплуатации

2.09.xx BA00065S/04/RU/
02.13

Новые добавленные
функции

WirelessHART, карта NI, модем FFusb;
модем Bluetooth MACTek, установка
файла DTM, обновление каталога DTM,
замена iDTM

Редактура Процедура установки драйвера USB в ОС
Windows 7

Компоновка Новый компакт-диск

2.10.xx BA00065S/04/RU/
03.15

Компоновка Новая система CMS

Новые добавленные
функции

HART через Rockwell Automation
ControlLogix, раздел PROFIBUS PA через
Rockwell Automation ControlLogix, уровни
доступа, проверка сети

2.10.xx BA00065S/04/RU/
04.15

Новые разделы и
изменения

HART через RSG45, Fieldgate SFG500 и
Siemens ET200M/iSP, PROFIBUS DP через
модем PROFIBUS и WAGO Remote I/O,
PROFIBUS DP через PROCENTEC ProfiCore,
уровень установки, уровень установки
SFG500

2.11.xx BA00065S/04/RU/
05.16

Новые разделы и
изменения

Вводные сведения о ПО FieldCare, Pepperl
+Fuchs LB/FB Remote I/O, HIMA,
PROFINET - шлюз PROFIBUS, PBI-PLUS,
Heartbeat Verification, сети I/O Link,
интерфейс с W@M

2.11.xx BA00065S/04/RU/
06.17

Документация
разделена на
руководство по
эксплуатации и
сопроводительные
документы

Учебное пособие по проектам FieldCare
SD01928S

2.12.xx BA00065S/04/RU/
07.17

Новая версия продукта
Изменения в разделе
«Управление»

-

2.13.xx BA00065S/04/RU/
08.18

Новая версия продукта -

2.13.xx BA00065S/04/RU/
09.18

Изменения Удалена тема о протоколе I/O-Link

2.14.xx BA00065S/04/RU/
10.19

Новая версия продукта IO-Link

2.15.xx BA00065S/04/RU/
11.20

Новая версия продукта • USB-накопитель вместо DVD-диска
• Управление лицензиями на ПО (SLM)

2.17.xx BA00065S/04/RU/
12.22

Новая версия продукта • Поддержка пакета FDI
• Обновление системы безопасности
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Версия
продукта

Руководство по
эксплуатации

Изменения Примечания

2.18.xx BA00065S/04/RU/
13.23

Новая версия продукта • Поддержка ОС Windows 11
• Microsoft SQL Server 2022 Express
• Обновление поддержки пакетов FDI,

Endress+Hauser и сторонних
производителей

• Обновленная версия PROFINET
CommDTM

• Обновленная версия CDI CommDTM
• Обновленная версия Flow Verification

DTM
• Обновление безопасности компонентов
• Руководство по безопасности

SD03193S
• Обновление каталога, сканирование

B&R и улучшение IO-Link
• Удалённые функции W@M так как

портал W@M был закрыт 31.12.2023г.

2.19.xx BA00065S/04/RU/
14.24

Новая версия продукта • Обновлен коммуникатор FXA291
• Обновленный Softing PROFIdtm
• Обновление DTM для верификации
• Обновленная версия PROFINET

CommDTM
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1  Информация о настоящем документе

1.1  Назначение документа
Настоящее руководство содержит всю информацию, необходимую для использования
программного обеспечения: от описания продукта, его установки и использования до
системной интеграции, эксплуатации, диагностики и устранения неполадок,
обновления программного обеспечения и его утилизации.

1.2  Используемые символы

1.2.1  Символы техники безопасности
ΟΠΑCHO

Этот символ предупреждает об опасной ситуации. Допущение такой ситуации
приведет к тяжелой травме или смерти.

ОСТОРОЖНО

Этот символ предупреждает об опасной ситуации. Допущение такой ситуации может
привести к тяжелой травме или смерти.

ВНИМАНИЕ

Этот символ предупреждает об опасной ситуации. Допущение такой ситуации может
привести к травме легкой или средней степени тяжести.

УВЕДОМЛЕНИЕ

Этот символ содержит информацию о процедурах и других данных, которые не
приводят к травмам.

1.2.2  Описание информационных символов

Символ Значение

Разрешено
Разрешенные процедуры, процессы или действия.

Предпочтительно
Предпочтительные процедуры, процессы или действия.

Запрещено
Запрещенные процедуры, процессы или действия.

Рекомендация
Указывает на дополнительную информацию.

Ссылка на документацию

A Ссылка на страницу

Ссылка на рисунок

Указание, обязательное для соблюдения

1. , 2. , 3.… Серия шагов

Результат шага

Помощь в случае проблемы

Внешний осмотр
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1.2.3  Символы, используемые в ПО FieldCare

Символ Значение

Запуск нового проекта.

Открытие существующего проекта.

Сохранение открытого проекта.

Печать открытого проекта.

Открытие буфера обмена.

Отображение каталога DTM.

Открытие документации для выбранного прибора или получение подробных сведений о нем.

Открытие инвентарного списка.

Активация протокола.

Добавление прибора к сети.

Удаление прибора из сети.

Создание новой сетевой топологии с помощью CommDTM и DeviceDTM.

Сравнение топологии сети периферийных устройств с фактической физической сетью, и
добавление устройств в существующую сеть.

Сканирование предварительно настроенной топологии и отображение отчета с информацией о
сканированном приборе.

Указание сведений о наличии соединения с прибором.

Передача информации из прибора в ПО FieldCare.

Передача информации из ПО FieldCare в прибор.

Функции, специфичные для выбранного прибора.

Добавление уровня установки.

Добавление элемента.

Удаление уровня установки.

Удаление элемента.

Открытие контрольного списка приборов для отображения выбранных приборов на установке.

Подтверждение замены прибора.

Отсоединено.  1)
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Символ Значение

Установка связи, готовность к связи  1)

Канал связи занят или операция связи отменена. 1)

Подключено  1)

Включение сенсорного режима

Выключение сенсорного режима

1) Индикатор состояния: указание сетевого / автономного состояния приборов в представлениях
установки и сети

1.3  Выделение текста

Выделение Значение Пример

Полужирный шрифт Клавиши, кнопки, значки программ,
вкладки, меню, команды

Start → Programs → Endress+Hauser
В меню File выберите пункт Print.

1.4  Используемые аббревиатуры

Аббревиатура Значение

APL Advanced Physical Layer (расширенный физический уровень)

CSV Значения, разделенные запятыми

DTM Device Type Manager (менеджер типов устройств; драйвер устройства)

FDI Field Device Integration (интеграция полевых приборов)

FDT Field Device Tool (инструмент для полевых приборов)

HART Магистральный адресуемый дистанционный преобразователь

I/O Ввод / вывод

IO-Link Фирменное наименование системы связи, включающей интеллектуальные датчики и
исполнительные механизмы

IODD Описание электронного устройства (описание устройства ввода / вывода)

IP Интернет-протокол

PROFIBUS Технологическая полевая шина

PROFINET Технологическая полевая сеть

SLM Управление лицензиями на ПО

TCP Протокол управления передачей

UDP Протокол передачи датаграмм

URL Унифицированный определитель местонахождения ресурса

1.5  Документация
FieldCare SFE500
• Начало работы KA01303S
• Учебное пособие по проектам FieldCare SD01928S
• Техническое описание TI00028S
• Руководство по безопасности SD03193S
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1.6  Зарегистрированные товарные знаки
PROFINET® – зарегистрированный товарный знак компании PROFIBUS User
Organisation (PNO), Карлсруэ, Германия.

PROFIBUS® – зарегистрированный товарный знак компании PROFIBUS User
Organisation (PNO), Карлсруэ, Германия.

IO-Link® – это зарегистрированный товарный знак организации IO-Link Community,
действующей внутри организации PROFIBUS User Organization (PNO), Карлсруэ,
Германия

FOUNDATIONTM Fieldbus – товарный знак компании FieldComm Group, Остин, Техас
78759, США.

HART®, WirelessHART® — зарегистрированный товарный знак FieldComm Group,
Остин, Техас 78759, США.

Ethernet/IP — зарегистрированный товарный знак ODVA, Мичиган, США.

Modbus® — зарегистрированный товарный знак организации Modbus, Хопкинтон,
США

Все другие торговые марки и названия продуктов являются товарными знаками или
зарегистрированными товарными знаками соответствующих компаний и
организаций.
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2  Основные правила техники безопасности

2.1  Требования к работе персонала
Физический и электронный доступ к периферийным приборам, сетям, компьютерам и
системам должен быть разрешен только группе уполномоченных лиц. Следовательно,
должна использоваться система доступа на основе уровней доступа. Внедрите
детализированные руководства и процессы по ограничению доступа к ПК и другому
оборудованию только группой уполномоченных лиц.

2.2  Назначение
FieldCare является средством управления активами предприятия на основе
технологии FDT ("Инструмент для периферийных приборов"), которое в зависимости
от версии может использоваться для настройки устройств, управления приборами или
контроля состояния. С помощью соответствующих драйверов типов устройств (DTM)
данная программа управляет периферийными устройствами и компонентами
системы независимо от протокола связи.

Необходимо использовать корректно настроенный межсетевой экран, который
блокирует все данные, не соответствующие требованиям безопасности. Для
дальнейшего повышения уровня безопасности необходимо отключить
неиспользуемые порты и ввести демилитаризованную зону или систему обнаружения
вторжений. Следует организовать стабильный процесс исправления ошибок в режиме
реального времени для всех средств и инструментов, таких как операционные
системы, интернет-браузеры, программы, приложения, базы данных и драйверы. На
ПК необходимо установить антивирусное программное обеспечение. Аппаратные
средства, программное обеспечение, встроенное ПО и другие компоненты
электроники следует использовать только в том случае, если они предоставлены
надежными источниками.

Для электронного доступа к программам, например для ПК, FieldCare, серверов SQL и
периферийных приборов рекомендуется использовать надежные пароли:
• Пароль должен содержать не менее 8 символов
• Не используйте имя пользователя, собственное имя или название компании
• Пароль не должен содержать полное слово
• Пароль должен значительно отличаться от прежних паролей
• Он должен содержать заглавные и строчные буквы, цифры и символы
• Пароль необходимо регулярно менять

Подробные указания по технике безопасности приведены в руководстве по
безопасности SD03193S (www.endress.com/SFE500)

2.3  Безопасность продукции
DEP – предотвращение выполнения данных
DEP – это инструмент обеспечения безопасности, который позволяет защитить
компьютер от вирусов, повреждений и угроз безопасности. Контролируя работу
программ, средство DEP содействует защите компьютера и обеспечивает безопасное
использование приложениями системной памяти. Как только приложение пытается
получить доступ к программе, средство DEP закрывает программу.

Настройка инструмента DEP
1. Выберите пункты: Windows key → Pause key → Advanced system settings →

Advanced.

2. В ответ на предложение системы введите пароль администратора.
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3. Выберите пункт: Performance → Settings.

4. Откройте вкладку Data Execution Prevention и выберите пункт Turn on DEP for
All Programs and Services. Если программы нет в списке, нажмите кнопку Add,
выберите программу и нажмите кнопку Open.

5. Нажмите кнопку OK.
 Будет отображено окно System properties.

6. Нажмите кнопку OK.

7. Перезагрузите компьютер, чтобы активировать изменения.

Номер Пояснение Состояние

0 Всегда выключено Средство DEP выключено для всех процессов.

1 Всегда включено Средство DEP включено для всех процессов.

2 Явное согласие Средство DEP включено для основных программ и служб Windows, вариант
по умолчанию.

3 Явный отказ Средство DEP доступно для всех процессов, кроме программ и служб.

Технические усовершенствования
Компания Endress+Hauser оставляет за собой право вносить технические улучшения в
программное обеспечение и устройства в любое время и без предварительного
уведомления. Если такие улучшения не влияют на работу программного обеспечения,
они не документируются. Если улучшения влияют на работу, составляется и
публикуется новая версия руководства по эксплуатации.

2.4  IT-безопасность
Гарантия изготовителя действует только при условии, что изделие смонтирован и
эксплуатируется в соответствии с настоящим руководством по эксплуатации. Изделие
имеет встроенные механизмы обеспечения защиты, предотвращающие внесение
каких-либо непреднамеренных изменений в его настройки.

Оператор должен самостоятельно реализовать меры по IT-безопасности,
дополнительно защищающие изделие и связанные с ним процессы обмена данными,
в соответствии со стандартами безопасности, принятыми на конкретном
предприятии.



Описание продукта FieldCare SFE500

12 Endress+Hauser

3  Описание продукта

3.1  Функции ПО
В настоящем руководстве по эксплуатации описывается использование ПО FieldCare
для установки соединения с приборами, которые оснащены интерфейсами HART,
PROFIBUS, FOUNDATION Fieldbus, Modbus, IO-Link и EtherNet/IP, с помощью модемов,
шлюзов и систем удаленного ввода / вывода.

3.1.1  Управление лицензиями на ПО (SLM)
Подробные сведения об обновлении ПО см. во вводном руководстве «Управление
лицензиями на ПО (SLM)» →   8

3.1.2  Уровни доступа
Сразу после установки ПО FieldCare функция пользовательского входа в систему
деактивирована, поэтому программу FieldCare можно запустить, не выполняя
процедуру входа в систему.

Активация пользовательского входа в систему
1. Разверните пункт FieldCare Administrator →   16.

2.

Необходимо выбрать User and User Groups → Configuration и активировать User
Login active.

Уровни доступа
Предусмотрены различные уровни доступа. Каждый пользователь может войти в
систему с определенным уровнем доступа, который ему назначен. Пользователь
получает полномочия на выполнение определенных функций. Это позволяет
предоставлять доступ к техническим и эксплуатационным функциям только тем
пользователям, которым это разрешено. Кроме того, предоставление прав доступа
можно ограничить определенным периодом.

• Создайте какое-либо количество пользовательских учетных записей
• По желанию установите параметры настройки для учетных записей
• По желанию измените пароль
• Пользователь может изменить пароль
• Пользовательский пароль действителен в течение определенного времени
• При необходимости удаляйте пользовательские учетные записи
• Назначайте уровни доступа пользователям согласно стандарту FDT

Уровень доступа Авторизация

Administrator Неограниченный доступ к выполнению любых функций, например разработке,
вводу в эксплуатацию и эксплуатации в ПО FieldCare.

Выполнение административных задач, например распоряжение
пользовательскими учетными записями.

Изменение или обновление каталога DTM.

Planning engineer Неограниченный доступ к выполнению любых функций, например разработке,
вводу в эксплуатацию и эксплуатации в ПО FieldCare.
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Уровень доступа Авторизация

Maintenance engineer Выполнение разрешенных функций в ходе ввода в эксплуатацию и во время
эксплуатации.

Замена, калибровка и регулировка приборов.

Запись параметров в память приборов, изменение или чтение параметров.

Выполнение специфичных для приборов операций в интерактивном режиме.

User Выполнение разрешенных функций в ходе ввода в эксплуатацию и во время
эксплуатации.

Контроль и ведение текущего технологического процесса.

Проверка текущего состояния прибора.

Изменение уставки для обеспечения корректной работы прибора.

Observer Контроль и ведение текущего технологического процесса.

Чтение параметров прибора и документации на подключенные устройства.

3.2  Область применения
Программа FieldCare представляет собой универсальный инструмент для выполнения
функций настройки и управления в отношении интеллектуальных полевых приборов.
Она обеспечивает удобную настройку приборов, управление процессом технического
обслуживания, техническое обслуживание на основе состояния и управление
активами предприятия. Возможна адаптация под различные потребности в
зависимости от условий лицензии с возможностью расширения в любое время.
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4  Установка
Подробные сведения об установке см. во вводном руководстве →   8
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5  Управление

5.1  Запуск FieldCare
‣

Откройте программу FieldCare.
 Открывается программа FieldCare.

5.2  Выполнение настроек в программе FieldCare
1. Откройте программу FieldCare→   15.

2. Закройте диалоговое окно FieldCare.
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3. Нажмите Extras → Options.
 Открывается диалоговое окно "Options".

4. Внесите необходимые изменения, например язык.

5. Сохраните изменения, нажав OK.

5.3  Выполнение настроек в программе FieldCare
Administration

Закройте программу FieldCare, прежде чем запустить программный компонент
FieldCare Administration.
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1.

Откройте программу FieldCare Administration.
 Открывается диалоговое окно "FieldCare Administrator Login".

2. Введите имя пользователя Administrator и пароль Admin и нажмите Login.
 Открывается диалоговое окно "FieldCare admin".

3. Выберите требуемое меню в левом столбце окна, например Users.

4. Откройте контекстное меню и выполните необходимые настройки.

5. Сохраните изменения.
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5.4  Пользовательский интерфейс

 1 Главное диалоговое окно программы FieldCare

1 Ракурс установки
2 Представление сети
3 Строка меню
4 Панель инструментов
5 Ракурс DTM / параметров
6 Дополнительные диалоговые окна
7 Строка состояния

5.5  Общие настройки

5.5.1  Настройки проекта
1. В программе FieldCare нажмите Extras → Options.

2. Откройте вкладку Project.
 Отображается вкладка "Project".

3. Выберите Prompt for project at start-up и нажмите OK.
 Диалоговое окно проекта отображается при каждом запуске программы.
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5.5.2  Настройки сканирования
1. В программе FieldCare нажмите Extras → Options.

2. Перейдите во вкладку Scanning.
 Отображается вкладка "Scanning".

3. Выберите флажок рядом с Connect after scanning if only one device is found and
automatically open the DTM in the Online window и нажмите OK.

После настройки сети отображается результат сканирования.

Если в результате сканирования программа FieldCare обнаруживает только один
прибор, автоматически устанавливается соединение с драйвером DTM и
происходит переключение в интерактивный режим. Если обнаружено несколько
приборов, то соединение с каждым драйвером DTM необходимо устанавливать
отдельно. В зависимости от драйвера DTM, выбор не подключенного к системе
прибора может привести к открытию окна с предложением установить
подключение. В противном случае следует использовать вариант Connect.
Настройка отдельных приборов не описана в настоящем руководстве по
эксплуатации. Данная информация содержится в руководстве по эксплуатации
соответствующего прибора.

По умолчанию ПО FieldCare использует для сканирования интерфейс FDT 1.2.
Если выбрать вариант Prefer FDT 1.2.1 scan, то в качестве альтернативы будет
использовано сканирование через интерфейс FDT 1.2.1.

Использование FDT 1.2.1 предпочтительно с точки зрения быстродействия,
поскольку используются собственные драйверы Comm/Gateway DTM.

5.5.3  Ракурс установки
Изменения, происходящие в ракурсе сети, автоматически синхронизируются с
ракурсом установки. Изменения, выполняемые в ручном режиме в ракурсе
установки, не отражаются в ракурсе сети. Это позволяет компоновать установку
вне зависимости от сетевой топологии.

Добавление уровня
1. Вызовите контекстное меню элемента.

2. Выберите пункт Plant View → Add Plant Level.
 Можно выбрать новый уровень установки.



Управление FieldCare SFE500

20 Endress+Hauser

 2 Структура ракурса установки

Уровень установки Описание

Enterprise Создайте только одну запись данного типа на высшем уровне
(0).

System
Range
Process cell
Unit

Создайте на уровне 1.

Range
Process cell
Unit

Создайте для типа Site.

Process cell
Unit

Создайте для типа Area.

Unit Создайте для типа Process cell.

Analysis device
Digital device
Pressure measuring device
Special
Flowmeter
Level transmitter
Temperature measuring device
Valve
Unknown device

Создайте для типа Unit.

Item Можно изменить элемент впоследствии с помощью функции
Change software.

 Это возможно ретроспективно не для всех типов. В
данном случае необходимо удалить тип и создать
новый.

 Пункт можно логически связать с прибором в ракурсе сети с помощью функции Assign. Для
удаления связи следует использовать пункт Unassign Device.
Тексты заголовков для вех пунктов можно впоследствии изменить.
Для каждого пункта можно создать примечание с помощью контекстного меню, а также можно
создать ссылку для каждого пункта на файл или адрес URL веб-сайта.

Прежде чем создавать ракурс установки, необходимо создать ракурс сети. Ракурс
установки соответствует фактической топологии установки; технологический ракурс
представляет собой иерархическое представление производственного процесса.
Любой пользователь с уровнем доступа Planning engineer или более высоким уровнем
доступа может создавать ракурсы установок или редактировать существующие.
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Элементы в ракурсе установки можно менять местами. Компоненты ракурса
установки можно переименовывать, добавлять или удалять.

Столбец Область применения

Plant TAG Обозначение каждой позиции в рамках установки.

Connections Символ, указывающий состояние (интерактивное / автономное).

Status Указывает текущее состояние диагностики.

Monitored Пункт для активации мониторинга текущего прибора с помощью функции Condition
Monitoring.

Critical Пункт для причисления прибора к группе критически важных.

Channel Указывает канал, по которому подключен прибор.

Address Указывает адрес прибора, назначенный для данной позиции установки.

Device type (DTM) Указывает тип, к которому относится прибор.

Физический прибор Указывает физический прибор, находящийся в конкретной точке сети.

5.5.4  Ракурс сети
Ракурс сети – это графическое представление сети приборов, относящихся к проекту
FieldCare.

Столбец Применение

Network TAG Сетевое обозначение прибора.

Connections Символ, указывающий состояние (интерактивное/автономное).

Channel Указывает канал, по которому подключен прибор.

Address Уникальный сетевой адрес прибора.

Device type (DTM) Указывает тип, к которому относится каждый отдельный прибор.

Физический прибор Указывает физический прибор, находящийся в конкретной точке сети.

5.6  Общие функции
Ракурс установки/сети
• Выбор пункта Контекстное меню → Customize Plant View
• Отображение диалоговых окон
• Отображение/скрытие столбцов
• Изменение расположения столбцов

Список функций
• Сортировка списка по заголовку столбца
• Изменение ширины столбца
• Изменение расположения столбцов с помощью функции копирования и вставки

5.7  Проверка сети
Сетевую топологию, которая отражена в ПО FieldCare, можно сравнить с фактической
конфигурацией физической сети. Это особенно полезно, если прибор добавляется в
существующую сеть. Проект может быть подготовлен в автономном режиме, а затем
загружен через ПО FieldCare. Таким образом можно проверить существующую
сетевую топологию и физическую топологию при внесении необходимых изменений.

Перед проверкой сети обратите внимание, что проверка проводится только для
устройств связи, с каждым из которых сопоставлен хотя бы один драйвер DTM. В
противном случае пункт меню Verify Network не активен.



Управление FieldCare SFE500

22 Endress+Hauser

Проверка сети
1. В ракурсе сети выберите прибор, для которого назначен по меньшей мере один

драйвер DTM.

2. Нажмите кнопку Verify network  на панели инструментов.
 Открывается диалоговое окно Communication channel.

3. Выберите необходимый канал и нажмите кнопку OK.
 ПО FieldCare сканирует выбранный канал.

По окончании проверки сети открывается диалоговое окно Scanning Result.
Отображается список активных устройств, а в столбце Status отражается
степень согласованности приборов в спланированной топологии с
фактической топологией.
Предусмотрено пять вариантов состояния
Типы и серийные номера приборов совпадают.
Типы приборов совпадают.
Типы приборов различаются.
Обнаружен новый прибор.
В проекте обнаружен не предусмотренный прибор.

4. Можно внести изменения с помощью контекстного меню соответствующего
прибора. Прочитайте/запишите данные прибора или замените тип прибора.
Нажмите кнопку OK, чтобы подтвердить внесение изменений.
 Изменения сохраняются.
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6  Системная интеграция

6.1  Настройка IP-адреса
• Необходимы права администратора
• Описание действительно для ОС Windows 7

Все устройства Endress+Hauser, оснащенные интерфейсом Ethernet, поставляются с
IP-адресом по умолчанию, например IP-адрес устройства Fieldgate FXA720 –
192.168.253.1. Для связи компьютера-хоста с веб-сервером устройства Fieldgate
FXA720 необходимо назначить IP-адрес в том же домене адресов, например
192.168.253.99. Дополнительные сведения можно получить у вашего сетевого
администратора.

Настройка IP-адреса для компьютера
1. Выберите пункт Пуск → Панель управления → Сеть и Интернет → Центр

управления сетями и общим доступом.
 Открывается диалоговое окно Сетевые подключения.

2. Выберите ссылку Управление сетевыми подключениями.

3. Вызовите контекстное меню подключения, которое следует изменить.

4. При необходимости
Введите пароль администратора или подтверждение.

5. Откройте вкладку Сеть.

6. Выберите пункт Протокол Интернета версии 4 (TCP/IPv4) в рубрике «Это
подключение использует следующие элементы».

7. Выберите пункт Свойства.

8. Запишите исходные значения IP-адреса и маски подсети компьютера, чтобы
восстановить их при необходимости в конце операции. Компьютер,
используемый в корпоративной сети, получит свой адрес автоматически.
Установите флажок Использовать следующий IP-адрес.

9. Введите IP-адрес, маску подсети и адрес шлюза по умолчанию в рубрике TCP/
IPv4.
 Настройки IP-адреса принимаются.

10. Нажмите кнопку OK.
 Процедура завершена.

6.2  Брандмауэр Windows
Если брандмауэр используется на компьютере, на котором работают и сервер, и
клиент, они должны быть запрограммированы для обеспечения взаимного
доступа. Настройка брандмауэра часто зависит от политики ИТ-безопасности
компании, поэтому необходимо проконсультироваться с
системным администратором, прежде чем продолжить работу. Кроме того, для
выполнения этой задачи требуются права администратора.

Порты, доступные для устройства Fieldgate SFG500, перечислены в следующей
таблице

Номер порта Идентификатор

TCP 60010 TCP_PCPS2_SFG500_PORT

UDP 60015 UDP_IDENTIFY_PORT

UDP 60020 UDP_ANNUNC_PORT
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Управление брандмауэром Windows
1. Выберите пункт Пуск → Панель управления → Брандмауэр Windows.

2. В левой панели выберите ссылку Разрешение запуска программы через
брандмауэр Windows.

3. При необходимости
Введите пароль администратора.

4. Установите флажок напротив программы, которой следует разрешить запуск, и
нажмите кнопку OK.

5. В левой панели выберите ссылку Дополнительные параметры.

6. При необходимости
Введите пароль администратора.

7. В диалоговом окне «Брандмауэр Windows в режиме повышенной безопасности»
выберите пункт Правила для входящих подключений.

8. В правой панели выберите пункт Создать правило....
9. Следуйте указаниям мастера создания правила для нового входящего

подключения.

10. Откройте вкладку Исключения.
 Открываются два главных уровня. К этим уровням можно добавить

исключения.
Пункт «Добавить программу» указывает, какие приложения могут отвечать
на запросы, поступающие в одностороннем порядке.
Пункт «Добавить порт» указывает, что брандмауэр должен допускать трафик
TCP через порты, используемые серверами.

11. На вкладке «Общие» установите флажок Включить (рекомендуется).

Брандмауэр активируется.
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7  Управление
В зависимости от режима хранения проекта, связанные с проектом данные
сохраняются в базе данных или в файлах.

7.1  Настройка языка управления
1. Откройте программу FieldCare.

2. Необходимо выбрать Extras → Options.
 Открывается диалоговое окно "Options".

3. Выберите язык во вкладке Display и нажмите OK.
 Язык сохраняется и будет введен при следующем запуске программы.

7.2  Создание проекта
Первые этапы создания проекта всегда одинаковы. По умолчанию отображается
диалоговое окно FieldCare, которое можно деактивировать в Extras → Options →
Project. Если установлен флажок None, диалоговое окно FieldCare не
отображается.
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Создание проекта
1. Откройте программу FieldCare.

 Открывается диалоговое окно "FieldCare".

2. Во вкладке "New" выберите пункт Create Project и нажмите Open.
 Программа FieldCare откроет новый проект с помощью компьютера-хоста.

7.3  Сохранение проекта
Проекты FieldCare хранятся в базе данных, но недоступны в виде файлов на
жестком диске. Чтобы получить доступ к данным файлам, следует использовать
ПО FieldCare в файловом режиме. Все проекты сохраняются одинаково.

Сохранение проекта
1. Необходимо выбрать File → Save As.

 Открывается диалоговое окно Save Project As.

2. Введите название проекта и нажмите Save.
 Проект сохраняется.
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7.4  Открытие сохраненного проекта
Открытие сохраненного проекта
1. В диалоговом окне FieldCare перейдите во вкладку Existing.

 Отображается диалоговое окно "Open Project" с последними открытыми
проектами.

2. Выберите требуемый проект и нажмите Open.
 Отображается проект.

Если проект не отображается на экране, нажмите View→ Network.

7.5  Экспорт и импорт в формате CSV
Структурная информация о ракурсах установки и сети (топология установки/сети)
может быть экспортирована в файл CSV и импортирована из файла CSV в проект
FieldCare.

Импортирование файла CSV
1. Создайте проект. →   25

2. Выберите пункт File → Import/Export → Import CSV file.
 Открывается диалоговое окно Import CSV file.

3. Выберите файл и нажмите кнопку Open.
 Данные, которые содержатся в файле CSV, импортируются в ракурс

установки и (или) ракурс сети.

Экспортирование файла CSV
1. Выберите проект.

2. Выберите пункт File → Import/Export → Export CSV file.
 Открывается диалоговое окно Exported topology.

3. Нажмите кнопку Export.

4. Выберите место сохранения, название и нажмите кнопку Save.
 Ракурс сети экспортируется в файл CSV.

7.6  Информация DTM
Диалоговое окно Information содержит всю информацию, актуальную для драйвера
DTM.
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Отображение информации DTM
1. Выберите Device Catalog в строке меню.

2. Нажмите View.
 Открывается каталог прибора.

3. Вызовите контекстное меню DTM.

4. Нажмите DTM Information.
 Открывается диалоговое окно "Information".

Варианты, которые можно выбрать в диалоговом окне "Information"
• Отображение базовой информации обо всех типах приборов, которые поддерживает

DTM
• Отображение информации DTM:

• Идентификатор производителя
• Идентификатор типа прибора
• Идентификатор подтипа прибора
• Информация о типе прибора

7.7  Отображение каталога приборов
Диалоговое окно Device catalog содержит список всех драйверов DTM и FDI Packages,
которые содержатся в системе управления приборами. Драйверы DTM можно
группировать по категориям, изготовителям или протоколам.

1. Выберите пункт Device catalog в строке меню.

2. Нажмите кнопку Display.
 Откроется каталог приборов.

7.8  Обновление каталога приборов
Подробные сведения об обновлении каталога DTM см. в разделе «Обновление
каталога приборов: вводное руководство» →   8
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8  Диагностика и устранение неисправностей

8.1  Общие сведения об устранении неисправностей

Неисправность Меры по устранению

SQL-сервер ПО FieldCare
не запускается.

Запустите SQL-сервер вручную:
• Запустите ОС Windows и введите строку services.msc в поле поиска.
• Выберите SQL-сервер (SQLFIELDCARE).
• Нажмите кнопку Пуск.

Отсутствует макрос
сканирования.

Импортируйте макрос:
• В папку ...\Endress+Hauser\FieldCare\db импортируйте файл

ImportScanningMacros.cmd.
• Затем перезапустите программу FieldCare.

Дублируются пункты
меню или отсутствуют
окна.

Выполните сброс:
• Закройте программу FieldCare.
• В папке ...\Endress+Hauser\FieldCare\Profiles удалите файл profile.xml.

Нарушен каталог
приборов.

Сбросьте каталог приборов FieldCare:
• Закройте программу FieldCare.
• В папке ...\Endress+Hauser\FieldCare\Frame удалите файл

FRMRepository.xml.
• Снова запустите программу FieldCare и обновите каталог приборов.

Если проблема не будет решена, обратитесь в торговую организацию Endress
+Hauser: www.addresses.endress.com
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9  Обновления ПО
Подробные сведения об обновлении ПО см. во вводном руководстве →   8
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